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1 Scope of this Manual
This manual contains information on safe and effective operation of Medical Insight A/S
products.

1.1 CE Mark

Figure 1-1 CE Mark

Class IIa 0297

This product is provided with a CE marking in accordance with the regulations stated in
the Council Directive 93/42/EEC of June 14, 1993 concerning Medical Devices. Medical
Insight A/S is certified by notified body DQS 0297 to Annex II- Full Quality System.
Easy Viz 4.0 User Manual Document Number 11134.

1.2 Copyright

Copyright subsists in this document whether it is Medical Insight A/S proprietary doc-
umentation or documentation made available by Medical Insight A/S under licence, and
therefore title to the document remains at all times and for all purposes with Medical
Insight A/S or with third parties from whomMedical Insight A/S has acquired licensed
rights.
No part of this document may be reproduced, copied, adapted or transmitted in any form
or by any means without the written permission of Medical Insight A/S. Medical Insight
A/S makes no warranties or representation, expressed or implied, with respect to the accu-
racy, completeness or usefulness of the information contained in this document and spe-
cifically disclaims warranties of suitability for any particular purpose. Medical Insight A/S
shall under no circumstances be liable for any damage arising from the use or inability to
use any information, apparatus, method or process disclosed in this document. Medical
Insight A/S reserves the right to make changes to this document without prior notice.
© Medical Insight A/S 2012

1.3 Contact

The EasyViz system is manufactured by Medical Insight A/S:

Medical Insight A/S
Krumtappen 4, 3
DK-2500 Valby, Denmark
Tel: +45 4655 0444
Hotline: +45 7026 0944
Email: helpdesk@medical-insight.com
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Chapter 1

Website:www.medical-insight.com

1.4 Cautions and Warnings

The following samples show how warnings, cautions, instructions and notes appear in
this document.

WARNING
Warnings are directions which, if not followed, can cause fatal or
serious injuries to a user, engineer, patient or any other person, or
can lead to a mistreatment.

CAUTION
Cautions are directions which, if not followed, can cause damage to
the system described in this manual.

ADVICE
Refer to the instruction manual.

NOTE
Notes provide advice and highlight unusual points. A note is not
intended as an instruction.

1.5 Disclaimer

Medical Insight A/S assumes no liability for the use of this document where any unauthor-
ized changes are made to the content or format thereof.
Every care has been taken by Medical Insight A/S to ensure the accuracy of the infor-
mation presented within this document. However, Medical Insight A/S assumes no respon-
sibility or liability for errors, inaccuracies, or omissions that may appear in this document.
Medical Insight A/S reserves the right to change the specifications of any referenced prod-
uct therein designed to improve reliability, function and/or design without further notice.
This document is provided without warranty of any kind, implied or expressed, including
but not limited to, the implied warranties of merchantability and fitness for a particular pur-
pose.

CAUTION in respect of document use within the United States of
America:
The document user should be aware that within the United States of
America, Federal law restricts certain referenced products to being
used only by or on the order of a qualified and registered physician.

1.6 Indications for Use-Intended Use

The Medical Insight EasyVizTM PACS System is a Diagnostic Softcopy Reading soft-
ware package to be used for primary diagnosis and clinical review of digital radiology
images. The product utilizes the conventional TCP/IP internetworking infrastructure avail-
able in most healthcare organizations, and it uses commercially available computer plat-
forms (Intel Pentium-based) and operating systems (Microsoft Windows XP, Linux). The
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1 Scope of this Manual

product interfaces to existing imaging equipment using the DICOM PS 3.16-2009 (Dig-
ital Imaging And Communications In Medicine) standard communication protocol as
described and developed by ACR. Lossy compressed mammographic images and dig-
itized film screen images must not be reviewed for primary image interpretations. Mam-
mographic images may only be interpreted using an FDA approved monitor that offers at
least 5 M-pixel resolution and meets other technical specifications reviewed and accepted
by the US FDA. The system does not permanently store or produce original medical
images.

WARNING
The user must strictly observe all warnings, cautions, notes and
safety markings within this document and on the product.

The EasyViz system is a software package that is used with general-purpose client-server
computing hardware to acquire, store, distribute, analyze, process, and display images and
associated patient data throughout a clinical enterprise. The EasyViz system performs
functions of digital image processing, measurement, communications, and storage.

The EasyViz system is used with specified computing hardware that supports DICOM-
based protocols for acquiring, transmitting, storing, viewing, processing, and printing
DICOM images and studies received from a number of modality types, including: CR,
DX, MG, IO, XA, RF, PT, CT, NM, US, MR, SC, ES, GM, SM, XC, VL, and OP.

The EasyViz system is used either for primary reading (interpretation or diagnosis) of
patient data (via EasyViz Diagnostic Workstations) or for clinical review of patient data
(via EasyViz Enterprise Viewer).

EasyViz Enterprise Viewers are not intended for use in the primary reading (interpreting,
diagnosing) of patient image data.

Because of the technical advantages of the EasyViz system and the ease-of-use of the sys-
tem, clinical workflows are improved and enterprise-wide access is provided to all nec-
essary data and analysis functions to all authorized users at all times and at all locations on
a variety of physical devices.

Intended User

The EasyViz system (4.0) is a clinical PACS imaging and data management software sys-
tem intended to be used by trained healthcare professionals, including but not limited to
physicians, nursing staff, and medical technicians.
This manual is written for trained users of Medical Insight A/S' products.

1.7 System Documentation

The documentation shall be kept with the system for easy reference. The most extensive
configuration is described within this manual, including information on software. Not
every function, option or accessory described may have been purchased or licensed in a
particular installation.
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Chapter 1

Technical documentation is available in the product service documentation that is avail-
able from the product manufacturer.

Monitors for Image Display

The quality and accuracy of radiological and other data displayed on monitors via the
EasyViz system are dependent upon the quality and a correct, periodically calibration of
the monitors themselves.

For EasyViz Diagnostic Workstations, it is required that image-display monitors are cer-
tified medical-grade devices that allow for adjustment and calibration of the monitor bright-
ness, contrast, color temperature, convergence, distortion, and other parameters in
accordance with DICOM Grayscale Standard Display Function (GSDF). Such adjust-
ment and calibration steps must be carried out periodically in accordance with the guide-
lines of the monitor manufacturer. Improperly calibrated image-display monitors can result
in the degradation of image quality, which can adversely impact the diagnosis of patient
image data.

For EasyViz Enterprise viewer, it is recommended that the highest-quality monitors are
selected for the intended use of the system. A wide variety of hardware devices and mon-
itors can be used as EasyViz Enterprise viewers, and there are guidelines for the mini-
mum type of hardware (computer and screen) that can be used for each type of EasyViz
Enterprise viewer. Where applicable, it is recommended that monitors for EasyViz Enter-
prise viewers be adjusted and calibrated with applicable tools (supplied by the monitor
manufacturer or from third-party vendors).

WARNING
EasyViz renders images in accordance with DICOMGrayscale Stand-
ard Display Function (GSDF). Hence, all monitors must be calibrated
correspondingly before any diagnosis of patient image data is carried
out.

WARNING
EasyViz Enterprise Viewer may not be used for primary reading of
patient image data.

Image Compression

EasyViz Enterprise Viewer uses lossy compression methods when displaying patient
image data that are being manipulated by the user. This is due to the streaming methods
that are used for communication between clients and servers. Depending upon the avail-
able bandwidth in the connection between the EasyViz server and the EasyVizEnterprise
Viewers and other parameters, the displayed images will be degraded to some extent and
caution should be used when viewing such images. When manipulation tasks are com-
pleted, the image data is displayed at full-fidelity and full-resolution.

Aside from the use of lossy compression methods in the streaming of information from
servers to workstation during data manipulation actions, the EasyViz system does not use
any other lossy compression methods.
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Measurement Functions

The measurement functions and tools for image data analysis that are part of the EasyViz
system comply with existing IHE descriptions and are tested and validated for accuracy as
part of the system development, testing, and verification procedures. However, users are
encouraged to perform their own accuracy checks of the system by using, for example,
images obtained of phantom devices with known dimensions.

Printing Functions

The quality and fidelity of radiological and other data printed out via the EasyViz system
is dependent upon the quality, capabilities, and correct adjustment of the printers. The
EasyViz system can print from COTS (commercial-grade) printers that are connected to
the network, from a computer acting as print server, and from DICOM printers.
DICOM printers are medical-grade devices designed to produce high-quality output with
minimal degradation of image data. It is important that the guidelines of the printer man-
ufacturers are followed regarding printer adjustments and calibrations. Medical Insight
A/S always recommends using DICOM printers for printing patient image data.
If a DICOM printer is not available, the best quality COTS printers should be selected for
those situations where a significant amount of patient image data will be printed out via
the EasyViz system. To print to any other type of printer, a screen capture must be done
of the 2D CAM, and then printing is done via an application external to the EasyViz sys-
tem.

It is only possible to print selected images or display set from the 2D CAM via Print in
the File Menu. A dialog opens showing the number of images that have been selected for
printing and provides options for choosing a print profile (including a printer). Advanced
users can place annotations on the printouts and select other advanced options.

NOTE
The DICOM Print function is only available to members of the group
DICOM Print. The system administrator assigns all group mem-
berships

Limitations for Mammographic Viewing

Lossy compressed mammographic images and digitized film screen images must not be
reviewed for primary image interpretations. Mammographic images may only be inter-
preted using an FDA approved monitor that offers at least a 5 Mpixel resolution and
meets other technical specifications reviewed and accepted by the US FDA.

Product Specifications

The EasyViz system is a software-only application designed to operate on a wide range of
computers, both EasyViz servers and various EasyViz clients (Enterprise Viewers and
Diagnostic Workstations). There are however, minimum or recommended hardware con-
figurations for each of the EasyViz components.
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1.7.1 Training

The user must have received adequate Medical Insight A/S training on the safe and effec-
tive use of the product before attempting to work with it. Training requirements may vary
from country to country. Users must make sure that training is received in accordance
with local laws or regulations that have the force of law.Your local Medical Insight A/S
representative can provide further information on training. See website for details
www.medical-insight.com.

WARNING
Safety is only guaranteed when personnel trained by Medical Insight A/S
have installed EasyViz.

1.8 Compatibility

EasyViz workstations are only to be used in combination with other equipment or com-
ponents if these are expressly recognized by Medical Insight A/S as compatible. A list of
such equipment and components is available fromMedical Insight A/S service on request.
Changes or additions to the equipment must only be carried out by persons authorized to
do so by Medical Insight A/S. Such changes must comply with best engineering practice
and all applicable laws and regulations that have the force of law within the jurisdiction of
the hospital.
EasyViz Enterprise can be used with all equipment complying with the minimum require-
ments specified by Medical Insight A/S.

1.8.1 EC MDD Directive

This product is compliant with COUNCIL DIRECTIVE 93/42/EEC of 14 June 1993 con-
cerning medical devices including revisions up to and including M5 Directive
2007/47/EC of the European Parliament and of the Council of 5 September 2007. Details
of the certification can be found on the Medical Insight Web Site www.medical-
insight.com

1.8.2 Standards

• ISO 14971 Medical Devices – Application of Risk Management to Medical Devices –
2009
• IEC 60601-1:2005, Medical electrical equipment –

Part 1: General requirements for basic safety and essential performance

• IEC 62304, Ed. 1: Medical device software – Software life cycle processes, computer
software.

• IEC 62366 Medical devices — Application of usability engineering to medical devices
(2007)

• US FDA compliance is as required by Part 820 of Title 21 of the Code of Federal Reg-
ulations (CFR).

• ISO 13485:2003 Quality management systems – Requirements for regulatory purposes.

- 6 -



1 Scope of this Manual

• Canada Health - Canadian Medical Devices Regulations (MDR) compliance is
reviewed annually

1.8.3 Configuration

It is not possible for end users to configure the EasyViz system, only system admin-
istrators can do this. Information on how to configure the system can be found in the sys-
tem administration guide.

1.9 Connectivity and Installation

EasyViz communicates with other devices in the hospital network by using the standards
DICOM &HL7. For detailed information, please see the DICOM conformance statement
and IHE integration statement. DICOM Conformance Statements can be found on the
Medical Insight A/S website www.medical-insight.com. Furthermore, the software can
use an enterprise Microsoft Active Directory Server for user management.

It is the responsibility of the hospital to ensure how the patients' legal requirements are to
be met, how the security of the patient records are maintained and tested, audited, admin-
istered locally to cover risks from third party access, and how the availability of the serv-
ices is to be maintained in the event of a disaster.

It is the responsibility of the hospital to ensure how types of access are identified, clas-
sified, and how reasons for access are justified.

EasyViz installation and configuration is performed by Medical Insight A/S or a person
trained and approved by Medical Insight A/S. (A limited number of configuration tasks
can also be performed by the customer after a Medical Insight A/S training course has
been provided). Contact your local support unit for more information.
Installation and configuration is described in the EasyViz Installation Guide, which is
available to people who have installed the system, and the support personnel of Medical
Insight A/S.

CAUTION
Administrators of the system must have in place satisfactory archive,
backup and retrieval systems and these must be periodically
checked.

CAUTION
Server users must be certain that the data they have selected and are
viewing is for the PACS being used.

1.10 Product Complaints

Any health care professional who has any complaints or has experienced any dis-
satisfaction in the quality, durability, reliability, safety, effectiveness, or performance of
this product must notify Medical Insight A/S.
If the device malfunctions and may have caused or contributed to a serious injury of a
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patient, Medical Insight A/S must be notified immediately by telephone, fax or written cor-
respondence to Medical Insight Customer Support at support@medical-insight.com.

Further Medical Insight A/S service support addresses all over the
world are accessible on the web site at www.medical-insight.com.

1.11 Messages

Under certain conditions, EasyViz will show a dialog box in the middle of the screen con-
taining a message. This message will tell that either a problem has occurred or that a
requested action cannot be performed. The user must read these messages carefully. It will
provide information on what to do from then on. Details on the contents of messages can
be found in the service documentation which is available to Medical Insight A/S service
personnel.

Figure 1-2 Message

Cleaning and Maintenance
Since the product does not come in direct contact with the patient or is used in the same
environment as the patient, cleaning and disinfection of the product is not different from
that of other IT equipment.
The system is maintained directly at the server and thus the user does not have to take any
special precaution regarding maintenance.

Environmental Protection

EasyViz is a software program and thus does not impact the environment negatively. Med-
ical Insight A/S recommends hardware to be used and treated in an environmentally
friendly manner.
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For more information – please refer to the following websites:

www.medical-insight.com

www.dcm4che.org

1.11.1 Translations

DIRECTIONS FOR USE are available in the other official languages eg:-(FRENCH) at
the request of the client.
ATTENTION -à la demande de l'acheteur, Le mode d'emploi est disponible en français

1.12 Safety Directions

CAUTION
Changes, additions or maintenance to the Medical Insight products
carried out by persons without appropriate qualification and training
may lead to serious risk of injury and damage to the equipment as
well as making the warranty void.

CAUTION
To avoid images being lost due to a power failure, the workstation
has to be connected to un-interruptible power supply (UPS) or an
institutional standby generator.

WARNING
Portable and mobile RF communications equipment can affect med-
ical electrical equipment. It is therefore recommended that the oper-
ation of equipment of this type such as mobile telephones, cordless
microphones and other similar mobile radio equipment be restricted
from the vicinity of this device.
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2 Introduction and Login
EasyViz fromMedical Insight A/S is an image and data processing system developed for
the use of physicians, nurses, technicians and others employed in the hospital sector. The
EasyViz system is a software package used with general-purpose client-server computing
hardware to acquire, store, distribute, analyze, process, and display images and associated
patient data throughout a clinical enterprise. The EasyViz system performs functions of
digital image processing, measurement, communications, and storage, and provides flex-
ible and simple access for the processing and visualization of medical images.

The EasyViz system is used for primary reading (interpretation and diagnosing) of patient
- image data, and the EasyViz Mammo system is likewise used for interpretation and diag-
nosing of mammography data.
Conceptually, the system consists of a central Workflow Manager which provides search
functions and navigation features for accessing patient data and images that are stored in
the system. From the Workflow Manager users can choose one or more items of patient
information or images. Once this is done the patient information or images are shown in
new windows. The visualization of images is provided by Specialized Clinical Appli-
cation Modules - CAMs - that are used to display common 2D images or 3D images
along with 3D reconstructions and Multi-Planar Reformatting (MPR). Currently, five
imaging or visualization CAMs are available in EasyViz: the General 2D Cam, the Gen-
eral 3D CAM, Fusion 3D CAM, Virtual X-Ray CAM, and Report CAM.

2.1 Logging In

To log in to EasyViz click on the EasyViz icon on the desktop and the login dialog
opens.

Figure 2-1 The EasyViz Login Dialog.
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From within the Login dialog it is possible to set different preferences for the use of
EasyViz. The Preference dialog opens when pressing the Preferences button in the Login
dialog.

Figure 2-2 Set Preferences

It is possible to choose which Login Server to use, and the user can choose which lan-
guage to run the system in. Note that a chosen language will only apply AFTER login.

It is possible to choose the size of the client window size by either choosing Fullscreen,
which opens EasyViz in full screen without decorations, or Maximized, which opens
EasyViz in full screen with decorations, or by choosing either of the screen size formats,
which can be set by the user.

When setting preferences for the use of EasyViz it is also possible to choose the number
of screens to display EasyViz on. The maximum number of screens is three. When the
number of screens is chosen the user is able to choose his/her preferred screen(s) between
the chosen number (screen 1,2, or 3).

At the bottom of the dialog the user is able to clear the stored usernames listed in the login
dialog.

As part of the EasyViz Work Station it is possible to change the size of the windows after
a CAM has been opened.

Roam Session

It is possible to roam a session in EasyViz, which allows for a whole session to be moved
from one unit to another. To roam a session the user must log in to the system as usual
and afterwards log in to another unit with the same username and password this time tick-
ing off Roam in the login dialog.

Share Session
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2 Introduction and Login

Two or more users are also able to view the same session in EasyViz at the same time.
The first user signs in and presses Share in the login dialog. The next users now log in
also pressing Share in the dialog. After logging in, the first user is presented with a dialog
where it is possible to create an optional SessionID (1). When users subsequently log in to
a shared session the same dialog is shown and the user now types in the created name of
the SessionID under Join (2). To start the shared session press Join.

Figure 2-3 Share Session 1) Creat SessionID 2) Join Existing Session

When a shared session has commenced the users are able to use the system as usual. It is
also possible for all users to interact in the window at the same time. The name of the user
who has last interacted in the window is shown first in line of names in the upper right
corner of the window. If a user wishes to leave a shared session it is important to press
Disconnect Me in the Start Menu and not Logout as this will terminate the session for all
users.

WARNING
Note that rights belonging to the user who first logs into a shared ses-
sion will be available for all users of the session, even for users who
normally do not have those rights.

2.2 The Workflow Manager

After logging in the Workflow Manager (WFM) window is typically displayed. It gives
access to patient data and images in an easy, rapid, and flexible manner.

Figure 2-4 The Workflow Manager.
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In the WFM it is possible to search for patients via name, patient ID or through image
data.
When a series is found it is shown in 2D CAM or 3D CAM.

Figure 2-5 General 2D CAM

Figure 2-6 General 3D CAM
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2.3 Introduction to CAMs

The intention of the CAMs (Clinical Application Modules) is to present or process med-
ical images. EasyViz has four basic CAMs: the General 2D CAM for most types of
image data, the General 3D CAM for volume reconstructions and multi-planar refor-
matting (MPR), the Fusion 3D CAM for viewing of dual modality studies, and the Virtual
X-Ray CAM for simulating 2D X-ray images derived from 3D CT data sets.
An image or visualization CAM is a window in the EasyViz system that is comprised of a
menu bar, a toolbar, and an area for image presentation or visualization. All CAMs have
the same construction but there are differences in the functions and features that are avail-
able in the menus and the toolbar. There is also a difference in the way image data is dis-
played and processed among the different CAMs.

Window Terminology

Images and other information are organized and shown within various windows in the
EasyViz system. Terminology for windows and other container objects used in the
EasyViz system is described hereunder.

Figure 2-7 Window Terminology.

- 14 -



Chapter 2

The overall EasyViz system window is called the Screen, and within this window one or
more Display Set Windows are placed, each of which contains a single display set. A Dis-
play Set Window contains one or more Image Panes which contain image data.
A Display Set Window and an Image Pane can be the same object, for example when
only a single image is being displayed.
Note that even if an Image Pane displays only a single image there may be additional
stacked images before or after the displayed image - these other images are viewed by
scrolling through the stack of images.

In all CAMs, the image pane or Display Set with the current focus has a white border,
and the activated functions will only operate on the image or display set with the current
focus.

A series contains of one or more images which have been retrieved from a scanner under
similar conditions, settings, or imaging protocols. A study may contain multiple series if
several imaging protocols have been followed during the acquisition process. If a series
contains more than one image, then these images may be grouped into one or more sub-
series. Multiple images that form a subseries are highly similar and related to each other -
the only variation may be the time at which each individual image is obtained, or the posi-
tion within the patient to which each image corresponds.

The Start Menu

On EasyViz Enterprise the Start Menu is located at the left edge of the Taskbar. From the
Start Menu, it is possible to view the following functions:

Online Help
Directs the user to the online user manual.
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About
Shows information about the EasyViz system.

Show license
This tab shows information on the license given to the user.

(Re)Start PACS WFM [Expert]
This function restarts the Workflow Manager.

Preferences
A number of preferences and properties in EasyViz are available to be set or modified
from the Workflow Manager. Preference settings are personal so that each individual user
of the system set system properties that apply only to that user.
Once property modifications are completed, click on the OK button to save the changes.

Disable auto-logout
This function enables a user to disable an auto log-out idle timeout, only however, if the
user is allowed to.

Disconnect session
This function allows an active EasyViz session to be disconnected and put to sleep on one
client device and then reconnected and resumed on another device (within 10 minutes).

Logout
Logout terminates the current session with the EasyViz system.The EasyViz system
should always be shutdown via the Logout function. If the window in which the system is
operating is closed, this does not necessarily terminate the session on the EasyViz server.

On EasyViz Work Station the Start Menu is not located at the top of the screen but at the
bottom Taskbar as part of a normal Windows layout. The functions in the WS startmenu
are similar to those in the EasyViz Enterprise startmenu.

Figure 2-8 Start menu, EasyViz WS
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Quick launching of CAMs is available only when a CAM is opened. If applicable for a
specific image the CAMs are shown in the upper right corner of the window. This applies
to both EasyViz Work Station and EasyViz Enterprise.
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3 Workflow Manager

3 Workflow Manager
The aim of EasyVis is to provide easy and fast access to patient and image data. Infor-
mation shown in the Workflow Manager is structured as a list of patients that each holds
another list of studies. Each study can contain one or more series which again can contain
one or more images.

In the column named CAM in the WFM it is possible to choose by which CAM a study is
shown. Note that not all CAMs allow viewing of more than one study at a time.

Figure 3-1 Workflow Manager: 1) Taskbar for choosing between open CAMs 2) WFM
Menubar 3) Profile Selector 4) Collapse and expansion of list of patients, Studies and
series 5) Column filters 6) Located patients, studies and series 7) Show selected study or
series 8) Search 9) Update worklist 10) Hierarchical structure of patient data.

Profiles

An image archive can contain millions of studies. The studies come from different types
of modalities such as CR, CT, and MRI and are focused on various anatomical locations
or features. Furthermore, various workflows and tasks are associated with the processing
of these studies. Profiles give the opportunity to select which studies or sequences are
shown and how these are shown. A profile is a combination of a specific set of search
criteria and a template that defines how the results of the search should be presented to the
user.
The search capabilities of the Workflow Manager can be set by the user or by a system
administrator to display patient data in accordance with specialized needs or requirements.
This is done by creating new Profiles in the system. If, for example, a user needs to see all
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X-ray studies completed within the last five days, a Profile is created to specifically match
this need.

3.1 Searching the PACS Archive

If the list of patients is extremely extensive one can either sort the list along the contents of
a particular column (5) or enter in search parameters in the filter fields above each column.
If a CT study for example is being sought after, by clicking on the Modality column all
CT studies are grouped together for easier perusal. This reduces the entries in the list to
those that match the filter strings that have been entered.

Search Expressions

Search expressions can be entered to match the beginning of a desired entry.
The basic wildcard characters for search expressions are underscore "_", question mark
"?", and star "*".

• The underscore character matches any single word.
• The question mark character matches any single character.
• The star character matches any amount of any characters, including empty strings.

The table below provides some examples of search expressions and the resulting search
results. Note that a blank search expression or a single underscore character will match
every possible result.

Search Expression Meaning

abc Match any item starting with the letters "abc"

*abc Match any item ending with the letters "abc"

*abc* Match any item containing the letters "abc" in sequence

abc*def Match any item starting with "abc" and ending with "def"

?a Match any item where the second letter is "a"

_a_b_c
Match any item containing the letters "a", "b", and "c",
but not necessarily in sequence

_, j*
Match any item with a second word starting with "j",
for example "Doe, John"

The specialized search features in the Workflow Manager are used in those situations
where a Profile does not provide access to the information or patient that is needed.
By clicking the Search button in the right corner of the Workflow Manager window the
Simple Search dialog is displayed.

Figure 3-2 Simple Search in the Workflow Manager.
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The intention of the Simple Search feature is to provide a rapid and simple way to search
the entire archive of patient data.
The results of a simple search are displayed in the WFM using a temporary Profile.
The dialog allows the user to pick between a set of predefined searches using the list (1).
Changing the search will cause the search fields (2) to update accordingly, so that only the
fields needed for the specific search is shown. The user can clear the values by pressing
the “Reset” button (4),and PACS can be changed by using the edit button (3). Note that
the default Study Date value is Today.

Customizable Search

This feature is only available for administrators and allows for editing and defining of
searches.

The searches are shown in the list (1). For each search it is possible for an administrator to
define or edit each title and its separate configuration including which group it is visible to
and which profile it is used for. The administrator can order the searches to ensure a spe-
cific order of the searches when shown to the user in the search dialog. The order is
changed using the up/down arrows (3) and can be edited, added or removed using the but-
tons (2).

Figure 3-3 Administration of Search
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When administrators add or edit a search, different settings are available.It is possible to
edit the title (1), visibility for groups (2), and comments (3). All available tags/fields that
the administrator can use in the search are shown in the available tags list (4). Fur-
thermore, the administrator can pick an available tag and move it to the list of search fields
(5), and by selecting a search field it is possible to change the behavior of the field by
tweaking the properties (6). The properties are:

• Label, which allows an overwriting of the name of the field e.g. from Patient ID > CPR
• Default value, which is the value of the field of the first search as well as the value when
resetting the search dialog
• Case, which converts the text to either upper case or lower case before the search is sent
to PACS
• Mode, where one can either choose Optional, Cross required, Required or Hidden in
order to determine the number of fields to be filled out in the remaining properties
• Matching, which denotes how a text is used for search
• Wildcards, indicating if a user is allowed to make use of * and ? as wildcards
• Minimal length, which denotes the minimum number of characters to be filled in
• Regular Expression, which is a regular expression used to control how a field ought to
look before it is considered to be filled out

WARNING
When creating a search, please ensure that the added fields are sup-
ported as matching keys by the PACS systems at your site. If a field
is not supported the value will not affect the search results but lead to
a result set with more results than expected.
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WARNING
In order to avoid overloading the system, it is important to adjust the
properties of the search fields and carefully decide which fields
should be included in the search to limit the impact the search will
have on the PACS when users activate it.

Figure 3-4 Edit Search

3.1.1 Advanced search

To activate the Advanced Search dialog box, select Advanced in the Simple Search box.
The dialog is divided into three groups: Patient, Study, and Series. For each group, it is
possible to put in various search criteria. It is possible to search on a known date, before
or after a set date, or within any interval between dates. The selections in each of the
scrolling menus in the search dialog box are specific to the type of data being searched
after.

Figure 3-5 The Advanced Search Dialog Box.

- 22 -



Chapter 3

3.2 Profile Editing

It is possible to edit a profile after it is opened in the WFM. The Profile Editor is used to
define a template that determines the manner in which information is presented in the
Workflow Manager table regarding patients, studies and series. To activate the Profile
Editor, select Edit Profile in the Edit Menu from the Menubar of WFM.

Figure 3-6 Profile Editor 1) Profile Group 2) Profile Selector 3) Add Column 4) Remove
Column 5) Column Properties 6) Values
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Within the Profile Group (1) it is possible to edit the name, type and owner of the profile
displayed in WFM. It also allows for the user to change the visibility and the level of the
profile. The Search dialog is opened by clicking on Search Criteria, and the Mode selec-
tion determines which type of client hardware the Profile will be available on.

Profile Selector

Via the Profile Selector (2) it is possible to adjust the viewing of the profiles by creating
rules, defining users, and determining sequence and visibility of the profiles.

Columns in WFM

Columns in WFM can easily be added (3), removed (4), or modified (5):

• To add a new column, simply click on Add Column (3) in the toolbar at the top of
the Profile Editor window.
• To remove a column, first click on a column in the bottom part of the Profile Editor win-

dow, and then click on Remove Column (4).
• To move a column in WFM, click on it and drag it to the new position in the table.
• To modify a column click on the column label and edit it through the Column Properties
(5) in the Profile Editor window.

The three scrolling menus (6) at the bottom of the Column Properties allow the selection
of information to show the level of patient, study, and series.

Columns can be reset to their default configuration by choosing Reset Columns Width
and Position from the Edit Menu in the WFMMenubar. This modifies the current profile
and saves the changes.

Show Prefetched Studies
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The Show Prefetched Studies dialog under the File Menu in the WFMMenubar shows
which patient data resides on the local workstation as part of prefetched data.

3.3 Import of Images

It is possible to show the contents of a CD or DVD that contains DICOM data in WFM.
Besides being able to work with DICOM data on a local workstation it is also possible to
import the image data to the PACS archive.

• Select Open DICOM CD-ROM/DVD from the File menu which will display the con-
tents of the CD/DVD in the Workflow Manager window.
• Then select the series that are to be sent and stored in the EasyViz archive and complete
by selecting Send Selected Images to the PACS Archive.

3.4 Export of Images

3.4.1 To CD-ROM/DVD

The export functions in EasyViz are used to save selected studies or series from the
PACS archive to a CD-ROM or DVD.
By selecting one or more studies and clicking Export Selected Images to DICOM CD-
ROM/DVD in the File, the Export dialog presents the following sub-sections:

• Export station
• Fileset ID
• Label
• Export format for images
• Export format for data

3.4.2 To Other Archive

To transfer images to another archive do the following:

1. Mark the studies to be exported
2. Choose Transfer Selected Objects in the File menu
3. The dialog shows the destinations to choose from
4. Press Send

Figure 3-7 Export Images to Archive
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NOTE
Not all archives are configured to receive images from EasyViz even
if they appear on the list of AE titles.
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4 Common functions for all CAMs in
EasyViz
This chapter presents the common functions for all CAMs in EasyViz. As part of the edit-
ing options for CAMs functions and tools can be placed in all menus, sub - menus, and
toolbars, and all functions and tools can be found in either a toolbar or the main menu.
Common for all CAMS is the default - menu bar at the top of the window. It contains
drop-down menus under File, Edit, View, Tools and Help. The content of the menus
differ from CAM to CAM and are customizable from the editor dialog found under the
Tools menu.

4.1 Home, Undo, and Redo

There are three available functions in the EasyViz CAMs for navigating through steps
and actions that have been performed. These are Home, Undo, and Redo.

The Home function returns the CAM to the initial state of the CAM when it was
started. If the Home function is used that step can still be undone by using the Redo func-
tion.

The Undo function becomes active once the user has taken action in using the CAM,
and each use of the Undo function moves backwards one step in the chain of steps that
were performed.

The Redo function becomes active once the Undo or Home function has been used.
Each use of the Redo function moves forward one step in the chain of steps that were per-
formed and then undone.

NOTE
Certain functions or features cannot be accessed or manipulated by
the Undo or Redo functions. For example, defining a Window
Width/level Preset cannot be undone (although the preset can be
deleted), the storing of markers or annotations cannot be undone,
and the modifications made to menus or toolbars cannot be undone.

4.2 Pan

The Pan function is available in 2D, 3D, Fusion CAM and Virtual X-Ray and is acti-
vated from a menu or a toolbar, or by using the Ctrl-LeftMouseButton com-
bination.

• To pan an image, left-click in a window, hold down the left mouse button, and move the
mouse around to pan the image.The function remains active until it is deactivated.

The Reset Pan/Zoom button cancels all pan motions or operations that have been per-
formed for the selected image or series.
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4.3 Zoom

The Zoom function is available in 2D, 3D, Fusion CAM and Virtual X-Ray and is
activated from a menu or toolbar, or by using the Shift- LeftMouseButtoncom-
bination.

• Click in a window with the left mouse button and drag the mouse, this results in the out-
lining of a rectangular region which represents the area to be zoomed. It is also possible to
zoom in 20 percent at a time by clicking with the left mouse button click in the image.The
function remains active until it is deactivated.

The Reset Pan/Zoom button cancels all zoom motions or operations that have been
performed for the selected image or series.

4.4 Magnifying glass

This function is available in 2D, 3D and Fusion CAM and is activated from the tool-
bar or a menu to magnify the area on which it is held. It is deactivated from the toolbar or
menu as well or with a right click on the mouse.

4.5 Exit

The Exit function terminates the current CAM. Any modifications to image data and
other data are not saved unless an explicit storage step is performed prior to terminating
the CAM (for example, saving a Compound Presentation State). Administrators however,
are able to set up 2D CAM to Auto Save.

4.6 The Sidebar

The sidebar is available in all CAMs and its main feature is the Bookmark widget and the
Patient Study Browser. The sidebar is automatically displayed when the cursor is moved

to the left side of the screen. By clicking the pin button in the upper right corner of the
sidebar the sidebar is locked.

4.6.1 Bookmarks

The Bookmarks tab is available in all CAMs. It displays all measurements, anno-
tations etc. which have been placed in the active patient’s studies. Every time a meas-
urement or annotation is applied in an image, a bookmark is automatically added in the
sidebar.
Bookmarks which have been added to a study remain on the list until the user deletes the
bookmark or goes to a new patient. When the next patient is displayed, previous book-
marks will be deleted if they are not saved as Compound Presentation States. A bookmark
can be renamed by double - clicking on it.
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4.6.2 Patient Study Browser

Specific for General 2D CAM and Report CAM is the Patient Study Browser . It dis-
plays a 3-level hierarchical structure of patient data which is available from the WFM
patient list. Just as in the WFM, the list can be folded in and out to display studies and sub-
sequent series. The study which is underlined and listed in bold is the study from which
the patient data is first opened in the WFM.

Figure 4-1 The Sidebar

The series level displays a thumbnail image from the series which can either be a single
image or a stack of images. A stack of images will be denoted by having two underlying
images behind the front thumbnail image.
It is possible to shift between the various images of the current patient image data by click-
ing on a thumbnail image and drag it to the image pane for display. The size of thumbnail
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images is also changeable by clicking on the Thumbnail button in the lower right
corner of the sidebar.

4.7 The LUT Viewer Tool

The LUT Viewer tool is available in the General 2D, 3D, Fusion 3D and Virtual X-Ray
CAMs. It contains two control objects: an upper cutoff bar and a lower cutoff bar. These
bars determine which image values are mapped to white (above the upper cutoff) and
which image values are mapped to black (below the lower cutoff). The image values
between these limits are mapped to shades of gray. The LUT Viewer is used pre-
dominantly with nuclear medicine data, and using this tool is equivalent to using the
Width/Level tool.

• To activate the LUT Viewer, click on the LUT Viewer button in a toolbar or menu.

4.8 Customize Menus and Toolbars

The function Customize is used for editing of menus and toolbars in all CAMs. It is pos-
sible to add, remove, or relocate functions and options.

(1) shows available elements to be added or removed
(2) shows the menu or toolbar to be edited
(3) shows elements in the current menu or toolbar
(4) shows the mode of the entity or the screen
(5) shows the tools available for adding, removing, or relocating elements

Figure 4-2 The Tool and Menu Customization Dialog Box

Creation of new menus and toolbars
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New menus and toolbars can be created by clicking on in the upper right corner of the
dialog. A box opens wherein the name of the new menu or toolbar is written. The new ele-
ment is now visible on the list (1) and a group can be added. New menus can be added as
part of another menu - if this is the case the new menu will appear as a sub-menu. If a
new menu or toolbar is not granted a group it will not appear on the list of available items.
A new menu or toolbar can be placed on the edge of the window or as a floating menu
above the window.

Customize Keyboard Shortcuts

EasyViz comes with a set of default shortcuts, all of which are fully editable. The Cus-
tomize Keyboard Shortcuts selection makes it possible to create and customize keyboard
shortcuts for various features in the CAMs:

Go to the Tools menu and select Customize Keyboard Shortcuts to open the Shortcut
Editor and allow for the creation of a new shortcut or editing of an already existing short-
cut. To create a new shortcut or edit an already existing shortcut, select the desired feature
in the Shortcut Editor and click on the Edit button, and hereafter the new combination of
keys and click OK to save.
To remove a shortcut, select the desired feature in the Shortcut Editor, click on the
Remove button and then OK. To reset all keyboard shortcuts to default shortcuts, click on
the Restore Defaults button .

The customized keyboard shortcuts are individual and are saved with the current user's
preferences. The system administrator can, however, add and customize shortcuts for all
users and groups.

4.9 Cursors and Default Tools

Active mouse cursors in the EasyViz CAMs provide assistance in the use of the system's
features and functions. As the mouse is moved around within the CAM, the cursor
changes to indicate what operations are permitted or forbidden, and how those operations
may be navigated. By clicking in a pane the new image now has focus.

When a function is selected in EasyViz the mouse cursor is always changed to fit the func-
tion. In order to toggle a function off, select the function again or choose another function.
Additionally, it is possible to click in any image or series pane with the right mouse button
to deactivate the function. If the mouse moves over an image that is in a display set which
contains multiple images, then the cursor automatically changes tosignify that clicking on
the image and dragging (or scrolling with the mouse wheel) will scroll through the stack
of images/slices.

Clicking on an image or series with the right mouse button brings up a context menu. This
menu provides rapid access to a number of functions.
At the bottom of the context menu, the Display Sets that are currently loaded in the 2D
CAM are shown along with selected information regarding the series data such as the
type of scan, imaging parameters, the scan date, and the number of images. The selected
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Display Set is flagged via a cross. Selecting any Display Set then replaces the selected Dis-
play Set with the new Display Set.

4.9.1 Keyboard and Mouse Shortcuts

In addition to the general navigation methods using the mouse and keyboard, there are a
number of navigation shortcuts for the most common functions that use the mouse and the
keyboard. The following table provides a list of the most common shortcuts.

Description Shortcut

Pan Ctrl+left mouse

Zoom
Shift+left mouse
Shift+scroll wheel

Change focus pane Arrow keys

Width/Level Middle mouse

Scroll through series (e.g.
CT or MR)

Scroll wheel/arrow keys up/down (one

image at a time)
Left mouse and drag up/down

Enlarge pane Enter

Image in full screen Double click

Undo Ctrl+Z

Redo Ctrl+Y

Deactivate a tool Right click

Add/remove toolbar Right click on menu bar

Return to multi pane view Escape

What's This? (help func-
tion)

Shift+F1

Help F1

Close images Ctrl+Q

- 32 -



5 Text overlays

5 Text overlays
Toggle Text Overlays is used to show or hide all text overlays in images and display
sets in 2D, 3D, Fusion and Virtual X-Ray CAMs. The Toggle Text Overlay function
only controls the text that is automatically displayed with image data in the CAM.

Text Overlay Editor (System Administrator)

The Text Overlay Editor opens through the tool menu and is a feature which makes it
easy to customize text overlays on images.

Figure 5-1 1) List of available text overlays 2) Tool buttons 3) Name of the text overlay 4)
Predicate filters 5) Textual content of text overlay 6) Pencil icon 7) Insert Macro 8)
Ignore Patient Name/ID Warnings 9) Potential overlap in text locations.

When an image pane is displayed an overlay is selected. Starting from the top of the list
(1), the first overlay qualified by its own predicates is selected. This means that overlays
with very specific predicates tend to be listed near the top of the list while more generic
overlays with fewer predicates are placed near the bottom. It is the responsibility of the
system administrator to rank and place the overlays on the list.

When a text overlay is selected on the list (1) its details are displayed in the remaining sec-
tions of the dialog. These details include Name (3), filter predicates (4), and the textual
contents of the text overlay (5). Filter predicates are entered, edited, or removed via the
tool buttons (2).
In order to apply text to an empty text location, move the mouse cursor to the desired posi-

tion and a small pencil icon (6) is displayed: Click to open the empty text location for
editing, or on an already present text to edit it.

Insert Macro
As a help, variables can be inserted in the overlay, e.g. ${DCM:PatientID}. Click on the
field in which the variable is to be inserted and then on the Insert Macro - button (7). A
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dialog from which the desired variable can be selected is now displayed.These variables
are predefined and can be used when editing filter predicates and text locations.

Ignore Patient Name/ID Warnings
Overlays without patient name and patient ID will generate a warning when the overlays
are to be saved. By checking the Ignore Patient Name/ID Warnings box (8), the EasyViz
system will ignore the warnings for that particular overlay.

NOTE
Sometimes the text of the different text locations may overlap (9).
Note that the macro text may take up much more space than the
actual information displayed in the overlay of an image.

WARNING

Do not save text overlays without patient name and patient ID.
If the text overlay has misplaced patient orientation labels it will gen-
erate an error. Follow the instructions of the dialog box to correct the
error.
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6 Save Secondary Capture
The Save Secondary Capture function is available in General 2D, 3D and Fusion 3D
CAMs.The images however, are saved differently in the CAMs.

To open the Save Secondary Capture selection , click on it in the File menu or use the
keyboard shortcut Ctrl-D to bring up the Save Secondary Capture Dialog Box.

In 2D CAM the dialog shows a sequence description, and under the Image selection the
currently selected images can be saved as secondary captures. A checkbox to save any
Image Filtering operations or Image Subtraction operations along with the images is also
available.

In 3D CAM and Fusion 3D CAM it is possible to save either all the images or the cur-
rently selected image as a Secondary Capture. It is possible to choose which PACS
archive the secondary capture is to be saved in, and the default location is the same loca-
tion that the images in the capture originated from.
If the secondary capture is to be saved in another PACS archive it can be specified in the
Host/IP field and the Port field.

Secondary Captures are not merely screen-shots of the images selected for storage. Lay-
outs are preserved, and if selected display sets contain multiple images all the images are
contained in the Secondary Capture.
After a Secondary Capture has been successfully saved, the new series is available from
the Workflow Manager in the same manner as any other patient data - except that the
modality listed as generating the series is Secondary Capture (SC). The Secondary Cap-
ture series is placed within the same study or exam from which the series originated.

- 35 -



7 Compound Presentations (2D) and Softcopy Presentations (3D)

7 Compound Presentations (2D) and
Softcopy Presentations (3D)
Compound presentation states for 2D and Softcopy presentations for 3D allow the user to
store an object in the PACS archive that describes how a particular set of images is
intended to be presented by that CAM. Along with information about the desired hang-
ing, compound and softcopy presentations are derived from DICOM structured reporting
initiatives. A Compound Presentation is a standard method for communicating clinical
information regarding patient data and images. All presentations are associated with an
existing Study and are stored along with that Study. In the Workflow Manager it is pos-
sible to view the Compound Presentations that are associated with any studies if this func-
tion is activated. This is done via the Show GSPS and Key Object tab in the edit menu in
WFM.

Load Compound Presentation

To bring up the Load Compound Presentation Dialog Box in 2D, click on the Load Com-

pound Presentation function in the File menu or use the keyboard shortcut Ctrl-L.
A dialog opens from which any available Compound Presentation for the selected study is
displayed and can be loaded. When a Compound Presentation is loaded, existing Display
Sets are replaced with new data and Display Sets.

To view all 3D Softcopy presentations for the chosen volume, the Load Compound Pre-

sentation function is opened in the File menu or via the keyboard shortcut Ctrl-L..
For 3D compounds small flags are shown on the list: Green flag means active and red
flag means in-active.

Figure 7-1 Load Compound Presentation 3D

Save Compound Presentation
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To bring up the Save Compound Presentation Dialog Box for both 2D CAM and 3D

CAM, click on the Save Compound Presentation function in the file menu, or use the
keyboard shortcut Ctrl-S.

Figure 7-2 Save Compound Presentation

The dialog allows the user to specify the name of the compound presentation and to
choose which information to save along with the presentation by marking Key Objects,
Layout and Presentation State.
The PACS Destination Tab allows selection of the destination PACS archive to which
the Compound Presentation is to be saved. The default location is the same from which
the images in the Compound Presentation originated but another PACS archive can be
specified via the Host/IP field and the Port field.

Select Presentation State (only 2D CAM)

To bring up the Select Presentation State Dialog Box click on the Select Presentation

State function in the View menu. In the dialog, all of the available Presentation State
Objects for the selected series or studies are shown. The Group By menu determines how
Presentation State Objects are arranged in a hierarchy. In the dialog Presentation State
Objects are sorted by Description, State and Date.

Figure 7-3 Select Presentation State
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The Presentation State Object is made up of four sub-objects - one for each series that the
Presentation State Object is associated with. The small flag before each Presentation State

Object defines its state: Green indicates that the Presentation State is currently active;
red that the Presentation State is inactive, and yellow that the state is partially
active. Through the Context Menu, Presentation is chosen locally for a single series. This
will activate presentations of more studies and the yellow flag will occur.

NOTE
The 2D Compound Presentation is based on the DICOM standard
Gray Scale Presentation State (GSPS) which means that it can be
used interchangeably with other vendors’ image displays. However,
there is no standard covering the 3D usage, so the 3D Softcopy Pre-
sentation States described here will only function with Medical
Insight A/S image displays.
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8 Help
A number of help features are provided in the EasyViz system which are described in this
section.

Online Help

The Online Help function brings up an interactive online help application which pro-
vides comprehensive information regarding the functions and uses of the CAM and the
EasyViz system. It opens in the section where the user is currently working, and the appli-
cation is added as a tab to the Taskbar at the top of the main window.

The Online Help application is divided into several areas: Index, Contents Bookmarks,
and Search. By clicking on either a bookmark, a headline, or a document in one of the
four functions the Viewer Panel is opened. The Online Help application also contains a
toolbar.

Figure 8-1 Online Help System Toolbar.

Online Help also includes a menu providing the following functions: File, Edit, View,
Go, Bookmarks, Help that all provide sub-menus to guide the user through the help func-
tions.

Report A Problem - Feedback Help

For each CAM, the Help menu has a selection titled Report A Problem . This selection
displays a User Feedback dialog which can be used to provide detailed feedback to the
support organization and developers of the EasyViz system. This feedback is sent via
email to a designated individual that manages and processes the feedbacks.

The Feedback type can be either a bug or an error within the system, a request for a new
or modified system feature, or any other type of comment.
The user name and user email address are provided automatically for the user that is
logged into the system, but users can remain anonymous if so desired.
The component of the system is chosen automatically in the case of certain errors or fail-
ures. Otherwise, this field is disabled.
The subject of the feedback and the actual description of the feedback are provided in the
fields in the center of the dialog.

At the bottom of the dialog, any associated log files for the session are shown and can be
attached to the feedback email. So can a screenshot. By clicking on the Acquire Screen
shot button a screenshot of the current session is taken and can be attached to an email.

What's This

The What's This help function activates a query feature so that clicking on any object
or area in the CAM displays a text box that describes the selected feature or function.
All CAMs also provide a tool tip help function which brings up a temporary text box
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when the mouse cursor is hovered over an object or function in the CAM. The tool tip
text box provides a short description of the object and functions for the control or area
under the mouse cursor.
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9 Introduction to General 2D CAM
The General 2D Clinical Application Module (CAM) is the main tool for viewing and
processing patient - image data. This chapter explains in detail imaging, image processing,
and navigation in the 2D CAM.

9.1 Navigation in the General 2D CAM

The General 2D CAM is activated from the Workflow Manager by selecting either a
study or a series. If only a single study is selected and a hanging protocol is applicable, the
EasyViz system automatically obtains and displays prior studies in accordance with the
rules in the applied hanging protocol. In all other circumstances, the selected studies or
series are simply opened and displayed in the CAM. Note that multiple studies or series
that are selected do not need to be from the same patient.

The General 2D CAM shows images grouped in display sets and the images are shown
side-by-side in the overview mode of the CAM.

Figure 9-1 2D CAM in Overview Mode

All image panes and display sets have a small Selection Handle in the upper left corner.
By using the Selection Handles it is possible to select several images at one time:

Click on a Selection Handle with the left mouse button while holding down the Ctrl
key on the keyboard or simply focus the pane and press the space key to select it.
To deselect an already selected image, click on the Selection Handle again while holding
down the Ctrl key and press the selection handle, or press space again.The selection
of windows is indicated by a yellow border that surrounds the window, along with the
Selection Handle becoming yellow. If a Display Set is selected via a Selection Handle
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and that Display Set contains a sequence of slice images then all the images in the
sequence are selected.

It is possible to move a window to a new location by clicking with a left mouse button on
a Selection Handle and drag the window to a new location on the screen.
To show a single display set or a single image in full screen, double click on it.
To minimize it again double-click again.

Groups in 2D CAM

If a study contains more series/display sets, these are displayed in groups in the General
2D CAM. A hanging protocol may define more display sets than the available screen
space can accommodate. To avoid that the image panes become too small, hanging pro-
tocols can be configured so that display sets are split up into Presentation Groups which
are shown one at a time. The tabs at the bottom of the 2D CAM window controls which
Presentation Group is displayed. To change between presentation groups, click on the
desired group tab at the bottom of the 2D CAM window, or press the key combinations
ctrl+PgUp or ctrl+PgDn.

Figure 9-2 Groups in 2D CAM

It is also possible to drag series between the groups in a CAM by using the Selection Han-
dle and drag either to the top edge of the window or to the bottom edge. By pausing the
sequence just inside a Display set, the series can be dropped, moving it from one group to
another.

9.2 DICOM Hanging Protocols

A hanging protocol (HP) is a template for a set of instructions that the 2D CAM uses
when displaying the contents of a study. The template specifies which images are to be
shown, where on the screen they should be placed, and how they should be oriented.

DICOM Hanging Protocols are a standard method for defining the selection, grouping,
and layout of images. Because DICOM Hanging Protocols are an accepted standard, any
defined protocols can be used on workstations from other vendors. A DICOM Hanging
Protocol is composed of two parts: a set of instructions that specify how images should be
placed on the screen, and a specification of when, or for what type of data a hanging pro-
tocol should be applied. As an example, a hanging protocol may only be specific to MR
images of the knee for workstations that have only one screen.

When the 2D CAM is launched features and functions of the hanging protocol are acti-
vated. The CAM searches for and rates the applicable hanging protocols by ranking pro-
tocols so that the most specific protocol receives the highest ranking. The highest ranking
hanging protocol is then automatically invoked to lay out the images contained in the
study.
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Hanging protocols are ranked with respect to the following criteria: Definition of appli-
cability, definition of environment, and the author or owner of the hanging protocol.

NOTE
Standard users can only define DICOM Hanging Protocols for them-
selves while system administrators can define DICOM Hanging Pro-
tocols for all users.

9.2.1 Changing Hanging Protocols

It is possible to choose another hanging protocol after a study is opened. If the auto-
matically selected hanging protocol is not the one desired it is possible to invoke another
hanging protocol instead.
To select another Hanging Protocol click the Select Hanging Procedure in the right
corner of the window. This will bring up a dialog that contains a short description of each
hanging protocol, the owner or author of the hanging protocol, and the rank of the hang-
ing protocol. This selection dialog can also be activated via the Ctrl+h key combination
or from the File Menu.

The name of the active DICOM hanging protocol is shown in the right corner of the win-
dow.

9.2.2 Automatic HP Layouts

The 2D CAM contains a Default Hanging Protocol for automatic layout of image
data. This is accessible from Select Hanging Protocols in the File Menu or from the short-
cut in the right corner of the window.
The Default Hanging procedure creates a display set for each series in the study being
viewed. The default window layout for default hanging protolcols is a 2x2 layout.

9.2.3 Creating and Editing of Hanging Protocols

DICOM hanging protocols can be created, edited or removed by selecting Edit Hanging

Protocol from the Tool Menu.

Figure 9-3 Dialog for Editing of DICOM Hanging Protocols.
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When creating a new hanging protocol it is possible to base it on an existing one by mark-
ing the one wished duplicated and pressing Copy.
Pressing either New to create a new hanging protocol, Edit to edit an existing one, or
Copy to copy an existing one will open the HP Editor.

When creating or editing a hanging protocol, several criteria are defined in order to use
the hanging protocol for a study which complies with the specific definitions.
To facilitate this process, EasyViz uses safe tags. Safe tags are the amount of DICOM
tags which in connection with a C-FIND is to be expected by the PACS archive to return
to the application. Safe tags display a list of those tags which can be expected to function
as criteria for a hanging protocol and are visible in the overview of hanging protocols by
pressing the button in the dialog.

NOTE
The Default Hanging protocol is not available for editing or deletion.

NOTE
Creation or editing of DICOM Hanging Protocols is advised for
advanced or expert users only.

Figure 9-4 Hanging Protocol Editor

General

In the General section of the dialog the Name and Description fields are used to provide a
name for the hanging protocol together with a short description of the hanging protocol.

The Predicates field defines which type of studies can be processed by the hanging pro-
tocol. It is possible to limit the application of the hanging protocol to studies from a par-
ticular modality, to a particular anatomical region, or to a particular laterality.
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The Environment fields define the conditions under which the hanging protocol is appli-
cable via screen settings. As an example, it is possible to specify that the hanging protocol
is only applicable for screens with a certain resolution.

The Owner field is used to specify which users or groups have access to the hanging pro-
tocol being edited or created. Group fields may not be present if the user does not have
permission to produce hanging protocols that can be accessed by other users.

Image Sets

An image set relies on the DICOM information that is present in the actual study selected
for viewing. Hanging protocols are often used to access and display a combination of
actual and prior studies. Therefore, image sets are broken up into two sections – one deal-
ing with non-time-based requirements, and one dealing with time-based requirements.
Time-based rules are often used to access and display prior studies that are related to the
current study.

Image set rules are composed of a series of phrases or expressions that specify require-
ments regarding the DICOM tags that are present in image sequences. Each phrase or
expression presents a specific requirement for a DICOM tag, for example, that the tag
shall have a certain value.

Figure 9-5 Editing of Image Sets

It is possible to create new image set rules by pressing the Add button or to remove an
image rule by pressing the wastebasket to the left of the rule.

To complete an image set, it is necessary to define which image sequences are to be
included in the hanging protocol. Typically, the sequences from the selected study are
included, along with various prior studies.

Display
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Before image data are displayed or presented, the applicable Image Sets are divided into
one or more Display Sets. A Display Set specifies where and how images in an Image Set
are shown on the screen and new display sets can be defined by pressing the Add button,
or can be removed by pressing the Remove button. It is also possible to Copy the settings
from one display set to another by pressing Copy.

Figure 9-6 Display Set Editing

Each display set is accessible by clicking on the tab for that particular Display Set.

Hanging protocols provide a series of Filter Operations for each Display Set used to
remove unwanted or unnecessary images or image sequences from the relevant Display
Set. Filter Operations are specified via dynamic expressions.

Sorting Operations are used to order the images in a display set. There are three types of
dynamic expressions for sorting: Field-type expressions, long-axis expressions, and
expressions regarding the time of study acquisition.

The General section allows for setting ofthe presentation group and the image set for a par-
ticular display set.

In the Tiling section, it is possible to specify how many panes a Display Set is divided
into.

In the Placements section, it is possible to specify on which screen the image sets should
be displayed, along with where on the screen the Display Set should be located.
It is not allowed to have overlapping display sets.

In the Presentation Intent section, it is possible to specify the orientation of Display Sets.
Orientations are given with respect to 2- patient coordinates: The first coordinate specifies
the contents of the right side of the Display Set, and the second coordinate specifies the
contents of the bottom of the Display Set. The special coordinate X indicates that the

- 46 -



9 Introduction to General 2D CAM

image should be oriented as specified in the DICOM dataset. It is also possible to specify
whether to invert the grayscale for the Display Set prior to display of the images.

9.3 Tools in 2D CAM

The 2D General CAM contains a list of tools available to the user. This chapter will
present the different toolbars and their functions. The toolbars available in 2D General
CAM are: the Main toolbar, the Annotations toolbar, the Key objects toolbar, the Image
subtraction toolbar, the Shutter toolbar, the Cine viewer toolbar, the Mammography tool-
bar and the NM toolbar. All toolbars are listed and can be chosen by right-clicking with
the mouse in the area of the bars or via the View Menu. It is possible to edit toolbars and
menus as wished by adding or removing tools through the Tools menu.

9.4 The Main Toolbar

The Main toolbar contains seven tools already described in the chapter on Common Func-
tions for all CAMS (ch.4), these are Home, Undo, Redo, Pan, Zoom, Reset Pan/Zoom
and Magnifying Glass.
The remaining tools will be described hereunder unless otherwise stated.

Figure 9-7 The Main Toolbar

9.4.1 Width/Level

Width and level is part of the LUT tools which are functions that control and modify the
Look-Up Tables (LUT) for image data. A LUT defines how intensity values in an image
are displayed on a viewing monitor as images are composed of pixels, and each pixel has
an intensity value. A LUT determines how those pixel values are mapped to actual light
intensity values on a display device.
By modifying the LUT, the mapping is changed between pixel values and light intensities
thus modifying the appearance or characteristics of an image (contrast and brightness).

Image contrast is known as the Window Width for an image, and image brightness is
known as the Window Level for an image. Together, Width/Level defines image bright-
ness and contrast in a displayed image or series.

Figure 9-8 Width/Level overview
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To activate the Width/Level function click on the button (1) and a set of cross-hairs
appears over the selected image or series corresponding to the window width and window
level settings for the image or series. Along with the cross-hairs presets may be displayed
as small markers with identifying text beside them (2). Clicking on the preset marker will
move the cross-hairs to the preset location and values.
Window Width and Level is also adjustable by clicking with the middle mouse button in
an image and move the mouse around.

The drop-down menu next to the Window Width/Level button (1) can also be used to
select preset window width and level settings that have been sent from the modality pre-
viously specified by the user, or provided by the system administrator.

To adjust the values grab the intersection point of the cross-hairs and move it about with
the mouse or grab an individual cross-hair with the mouse and move it.

Histograms

A histogram (3) provides information on the distribution of intensity values in an image.
In the 2D CAM Histogram objects can be shown for each image that is viewed.
To activate the display of a Histogram object for each image or series click on the Toggle

Histogram button in the View Menu.
The diagonal line represents the LUT mapping between pixel values in the image data
and the light intensity values of those pixels on a computer display. By modifying this
LUT mapping, the display characteristics of the displayed image are modified.

CAUTION
Histogram objects should only be used on pure grayscale images.

Edit Window Width/Level Presets
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To create or edit a Window Width/Level preset select the Edit function (4) to bring up the
Preset Editor dialog.
The editor is composed of a name for the preset, zero or more predicates, a window width
and a window level value, a priority, an origin, and visibility value, which determines to
which groups of users a particular preset is available – (this selection can only be made by
the system administrator).
It is possible to show non-editable presets by ticking off the box in the left corner.

Figure 9-9 The Preset Editor for Width/Level presets

9.4.2 Invert

This function opens up a LUT- inversion of a wished image or series. The gray scale
values are hereby inverted to an image or sequence.

9.4.3 Toggle Image Filtering

The Toggle Image Filtering selection turns image filtering for a selected image on and off.
Image Filtering is performed as a matrix convolution, which requires that the application
of the filter at each pixel in the image, and a small area around each pixel is math-
ematically evaluated to determine a new pixel value.

To select an image Filter, click on the drop-down menu next to the Toggle Image Fil-

tering function to display the two default image filters: Default Unsharp Mask and
Default Gaussian Blur.
The Unsharp Mask is used for edge enhancement to make edges clearer and more
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prominent in an image.
The Gaussian Blur Filter is used for noise reduction to make structures and objects more
blurry in an image, which often reduces noise appearing as small specks or dots.

When a new Filter is chosen via the Toggle Image Filtering selection, a dialog box is dis-
played.

Figure 9-10 Filter Question, Image Filtering

Apply activates the new filter and Image Filtering is performed with the new filter on the
image that has already been processed.
Do Nothing activates the new filter but no Image Filtering is performed.
Replace activates the new filter and Image Filtering is performed with the new filter on
the image but the processing of the previous filter is removed.

Image Filtering Configuration [Expert]

Additional custom filters can be designed and added by activating the Filter Selection
from the drop-down menu under Edit. From this dialog an existing filter can be edited or
deleted or a new filter can be defined by activating the Filter Configuration by pressing
New.

Figure 9-11 Filter Configuration
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To create a new filter, name the filter and select the number of times that the filter should
be applied consecutively to the image (the maximum is 99). Specify the filter type, along
with the filter size and press OK.
If Custom Convolution is chosen as the Filter Type the Convolution Editor is brought up
when the Customize Filter selection is made, and the two default filters can be chosen to
serve as templates from which to custom design the new filter. The Reset selection of the
Convolution Editor changes all Matrix Values to zero.

9.4.4 Show Overview Function/Single Display Set Function/Single Image Func-

tion

These functions change the viewing mode of the 2D CAM so that either all Display Sets

are shown as an overview , or the currently selected Display Set is the only display
shown in the Presentation Group , or the currently selected image is the only image
shown within the Presentation Group .

9.4.5 Screen Layout/Display Set layout

These functions are used to modify screen layouts.

Screen Layout controls the splitting up of the screen for the presentation of display
sets and Display Set Layout defines the configuration of image panes in a display set.
By pressing either a dialog opens that allows the user to determine rows and columns for
the layout. Each of the layout buttons have an associated drop-down menu that likewise
enables the user to decide rows and columns for the display sets.
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By modifying the layout of the screen via the button Presentation Groups in 2D
CAM are automatically added or removed so that the desired screen layouts can be accom-
modated.

9.4.6 Horizontal/Vertical Flip

Flipping is done either along the vertical or horizontal axis.

The Vertical Flip Tool flips the selected image or series along the vertical axis. The
Horizontal Flip Tool flips the selected image or series along the horizontal axis.
When an image or series is in a flipped state a Flip Flag is added to the right side of
the image pane.

9.4.7 Rotate Clockwise/Counter Clockwise

To rotate a selected image or series by 90 degrees clockwise click on the Rotate Clock-

wise Tool .
To rotate a selected image or series by 90 degrees counter clockwise click on the Rotate

Counter Clockwise Tool .

When an image or series is in a rotated state a Rotation Flag is added to the right
side of the image pane.

9.4.8 Localizer and Scout Lines

Localizer and scout lines make it possible to see where a given slice image is located
within another image. Many CT and MRI modalities specify via DICOM codes which
images can be used as scout images for which stacks of sliced images. Not all modalities
however, provide this information automatically therefore, the EasyViz system provides
functions that allow the selection of a scout image along with a stack of sliced images
which are then displayed together with localizer lines on the scout image showing the posi-
tion of a particular slice image.

NOTE
Optimally, the scout image and the sliced images should be orthog-
onal to each other, however, under Preferences, the angle can be
adjusted.

Add localizer lines

It is possible to manually add and remove localizer lines in an image by adding the func-

tion to a menu or a toolbar.

By selecting the slice-image-set and the position you wish displayed via scout lines a
scout image can be chosen. Once a scout image and a display set containing slices have
been selected the scout image displays the localizer line and slice number and the position
of the currently displayed slice image is shown by the localizer line.
To remove localizer lines from a scout image, click on the small red triangle that is located
at the top right side of the set of localizer lines.

Floating Localizer Tool
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To add floating localizer lines click on the Show Floating Localizer Lines on Scout
and once the mouse cursor is hovered over a display set localizer lines automatically
appear on the matching scout image and the position of the present slice is displayed on
the scout image by a highlighted yellow localizer line. The first and last slice of the stack
are highlighted by green lines on the scout image, and the intermediate lines are indicated
by dots along the scout axis.

Localizers can be locked in place by clicking on the icon , and the line can now be
grabbed and moved to a new position. While the localizers are locked, the scout icon

changes to .

Toggle Localizers and Scouts

To toggle the display of localizer lines on a scout image on or off click on the Toggle

Localizers selection in the View Menu. This also activates/deactivates the connection
between a scout image and the display set containing slice images. All localizers in the 2D
CAM are controlled by this toggle function.

9.4.9 Link mode

The Link tool makes it possible to link two or more display sets or series together such
that scrolling, zooming and panning in one series is automatically synchronized with
scrolling through another series.

To activate the tool click on the Selection Handle in two or more display sets that you
wish to link together while holding down the Ctrl key. It is also possible to activate it
by using space to select o deselect a display set. After selecting the display sets click on

the Link tool button and the icon is shown in the right corner of series that are linked
together.

To deactivate the tool click on the button or on either of the indicators.

Linked image sequences are synchronized in one of two ways: If the underlying DICOM
information for the linked series specifies spatial positions then the synchronization is
done only according to spatial position. If such information is not available the syn-
chronization is done according to slice position.

9.4.10 Toggle Text Overlay

The Toggle Text Overlay function is described chapter 5.

9.5 The Annotation Toolbar

The Annotation toolbar contains a series of annotation tools and measurements tools that
are all customizable from the Tool Menu. The tools allow the user to measure distances,
angles and intensities of image data.

Figure 9-12 The Annotation Toolbar

Some general functions apply to all tools:
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A tool is activated through a click on the specific icon in the toolbar. To deactivate a tool
either click the right mouse button or simply choose a new tool.
It is possible to move a whole measurement or just one of the measurement points by hold-
ing down the left mouse button and dragging either the line connecting the points or just
one of the points.

To delete a measurement click on it in one of the image panes and it will turn red, or mark
it in the sidebar and press Delete on the keyboard.

The Toggle Measurements and Annotations Tool toggles between displaying and hid-
ing all measurements and annotations applied to a selected image or series.

The Clear Measurements and Annotations Tool removes all measurements and anno-
tations applied to a selected image or series. To undo a clearing step the Redo function
can be used.

After adding annotations and measurements to an image it is possible to save these as a
compound presentation in the PACS as described in chapter 7 on Compound Pre-
sentations and Softcopy Presentations. When annotations and measurements have been
loaded into an image they are shown in yellow and cannot be changed.

9.5.1 Text Annotations

The Text Annotation Tool can be used to add text on images. Once you activate the
tool, a dialog opens wherein the text is written. It is possible to place the text in an image
as an anchor point, as a fixed position or in a vertical orientation.

9.5.2 Marker Tool

The Marker tools are used to draw attention to various structures, objects, or areas in
images. Three marker tools are available from the drop-down menu of the tool: the Arrow

Tool, the Freehand Tool, and the Ellipse Tool .
To move an annotation made with a marker tool hold down the left mouse button while
dragging it.

9.5.3 2-Point Distance Measurement

The 2-Point Distance Measurement tool is used to measure a current distance of a
defined line segment between two measurement points. It is possible to define several 2-
Point distances when the tool is active.

9.5.4 N-Point Distance Measurement tool

The N-Point Distance Measurement tool is likewise used to measure distances
between measurement points but it has the ability to place as many points as wished for.
As measurement points are placed, the current distance of a defined path is displayed. To
stop the line of measurement points double-click on the mouse or use the right mouse but-
ton which will also deselect the tool.
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9.5.5 Distance Ratio Measurement

The Distance Ratio Measurement tool is used to rate a distance between two line seg-
ments. While the tool is active, several line segments can be defined.

9.5.6 3-Point and 4-point Angle Measurement

3-Point and 4-point Angle Measurements are used to measure angles in images by
placing connected points to calculate an angle. For 4-point measurements 4 points are
placed on two separate lines hereby allowing for an angle to be measured without the
lines necessarily being connected.

9.5.7 Cobbs Angle Measurement

The Cobbs Angle Measurement has the same function and purpose as both 3-point
and 4-point measurements. It calculates an angle in a chosen image but differs from 4-
point measuring in its presentation of the angle as it connects the lines placed in an mage
hereby showing an angle with a connected line.

9.5.8 Circular Intensity Measurement

The Circular Intensity Measurement tool is used to measure the intensity value for the
underlying image pixel of an area in the image. While the tool is active several Circular
Intensity Measurements can be made in the same image. While the tool is active, several
regions can be defined. The tools are used to measure the intensity value for the under-
lying image pixel of a point in an image and the tools provide basic statistical information
regarding the selected area in an image including size of area covered, minimum intensity
value, maximum intensity value, mean intensity value, and standard deviation for the inten-
sity value for the pixels in the selected region. The area of the selected region is displayed
in the measurement results.

9.5.9 Freehand Intensity Measurement tool

The Freehand Intensity Measurement tool is likewise used for measuring of intensity
values in an image and has the same functions as the Circular Intensity tool apart from the
values being measured from an area inserted by a freehand drawing.

9.5.10 Pixel Intensity Tool

The Pixel Intensity Measurement tool measures intensity from points in the image.
Also, holding the tool over the image will show the pixel position in the lower part of the
application.

NOTE
Pixel intensity measurements are only supported on monochrome
images.
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9.6 Key Objects in General 2D CAM

Key Objects are a standard DICOM methodology for identifying objects or changes to
images as keys, hereby helping other users to view information on objects and changes in
patient data.

Figure 9-13 Key Objects Toolbar

It is possible to add a Key object by activating the tool Add to Key Objects Selection
and mark the image(s) wished as Key images. To remove the mark of an image as a Key

image press Remove From Key Objects Selection .

The Key Objects Selection Documents function brings up a dialog which lists all Key
Object Selection Documents for the current study or series. It allows for activation or deac-
tivation of one or all Selection Documents.

If the Scroll Key Objects Only function is activated, scrolling through a series of image
data will display only those images marked as Key Objects. If the study or series image
data is viewed in side-by-side panes all images are shown.

To solely display images marked as Key Objects in a study or series press Show Only

Key Objects , and images not marked as Key Objects will not be visible under any dis-
play mode.

Images marked as Key Objects contain an icon that indicates its status.

To un-mark all Key object images in a study or series press Clear Key Objects Selection

.

9.7 Image Subtraction in General 2D CAM

Image subtraction is an image processing operation in which intensity values from a mask
image are subtracted from corresponding intensity values in a target image, pixel by pixel
to highlight the changes between two very similar 2D images. The modified target image
is rescaled in intensity values to utilize the full dynamic range of the original image.

Figure 9-14 Image Subtraction Toolbar

It is possible to perform an Image Subtraction by toggling on one of the Image Sub-

traction Tools: One-To-One Subtraction , One-To-Many Subtraction , or Display
Set Subtraction . Activation of one of the tools will allow the user to choose the Mask
image and the Target image. The subtraction step is then performed as the Mask image is
subtracted from each corresponding image in the Target image hereby modifying the Tar-
get image.
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The target image or images are marked with an icon to indicate that the image subtraction
operation has modified the image data.

Display sets and images containing image subtractions will activate the Clear All Sub-

tractions tool . To remove all image subtractions in the series, click on this tool.
To remove subtraction from an image, select the Target image and click Remove Sub-

traction Tool or click the Subtraction flag in the image.

Figure 9-15 Image Subtraction - Completed Display Set Subtraction.

To turn off the display of image subtractions for all image data in any series, press Toggle

Image Subtractions .

NOTE

It is possible to save all image subtraction steps as Presentation
State objects in Compound Presentation States as described in chap-
ter 7. When a study or series containing image subtractions is loaded
as a compound presentation, a dialog is displayed requesting con-
firmation to apply the subtraction steps to the image data.

9.8 Shutters in General 2D CAM

Display Shutters are overlaid onto images to determine which areas of an image are vis-
ible. Display Shutters are used to focus upon an area of interest in an image and to remove
areas of distraction from an image.

Figure 9-16 The Shutter Toolbar
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There are three types of Display Shutters: rectangular, circular and polygon.
Only rectangular and circular shutters can be added and edited in EasyViz- polygon
shutters can be viewed if they come with the image.

After activating either the Rectangular Shutter or the Circular Shutter from the tool-
bar, click in an image and drag the mouse button to size the shutter.
The first click with the mouse button defines a corner anchor point for a rectangular
shutter or a circular shutter. Areas outside of the shutter area are still partly visible to aid in
placement of the shutter. Once the mouse button is released, the shutter is defined and
areas outside of the shutter are no longer visible.

Rectangular and circular shutters are combinable in a single image. If combined, only the
area of the image that lies within the intersection of the two is visible. If the shutters do not
intersect, no part of the image is visible.

Figure 9-17 A Rectangular and Circular Display Shutter in the Same Image

Display Shutters have two types of handles: a Resize Handle and a Position Handle. The
cursor changes shape to indicate which type of handle can be selected.

Once a shutter is applied to an image, the Rectangular Shutter icon or the Circular
Shutter icon , is placed on the right side of the image to indicate that the image data has
been modified.
A shutter is removed by clicking on the respective icon in the image.

To turn off all display shutters in a CAM, press Toggle All Shutters .
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Once display shutters have been defined they can be saved in the PACS archive as Pre-
sentation State objects (cf. chapter 7) associated with the patient image data for which the
shutters were defined.

9.9 Cine Viewer in General 2D CAM

the Cine Viewer automatically displays images in sequences one after another, analogous
to the image frames that are displayed when viewing a movie.

Figure 9-18 Cine Viewer Toolbar

To initiate cine mode and display the images in order from first to last, click on the Play

button .
To initiate cine mode with the images displayed in reverse order, click on the Reverse but-

ton .
It is possible to halt the cine viewing mode by pressing Stop or pause it by pressing
Pause .
The Ping-Pong button initiates a cine mode in which images are displayed in the order
first-to-last (starting with the current image), then last-to-first, in a continuous back-and-
forth loop.
The speed of images shown each second is editable from the toolbar, via the small up and
down triangles or by entering a number directly into the control box.
The minimum frames per second (FPS) is 1 and the maximum is 30 FPS.

The frames-per-second speed that is set is not necessarily the speed achieved. The actual
FPS speed achieved depends upon the bandwidth and quality of the connection from the
client device to the EasyViz server. If cine mode runs erratically and not smoothly, it is
advisable to decrease the FPS speed to achieve smoother cine performance.

The function Use Datasets Recommended Display Frame Rate denotes a default set speed

.
The functions Previous/Next take the user to either the previous or the next image

While the cine mode is active, other functions can still be performed on the image data,
such as panning, zooming, image filtering, etc.

9.10 Mammography Imaging in General 2D CAM

Mammography viewing is accessible from the 2D CAM and provides advanced navi-
gation tools that improve speed and reliability when reading mammographies. The
mammo hanging protocol supports fast navigation through full screen viewings of
mammo pairs.

Figure 9-19 The Mammo Toolbar
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If Computer-Aided Detection (CAD) objects are available with the images, the Mam-
mography Computer-Aided Detection Structured Report (CAD SR) dialog will open auto-
matically when the images are loaded in the CAM. This dialog displays information on
CAD findings:

• Algorithm type version
• Algorithm versio
• Date
• Etc.

Each CAD object comes with a specified Rendering Intent which can be either
“Required” or “Optional”. By default, all CAD objects that have Rendering Intent to be
“Required” will be enabled in the image.

Click OK to close the dialog and Open the CAD Object Dialog to reopen.
To toggle all CAD objects on/off, press Toggle all CAD objects On/Off .

Each of the CAD objects will be marked in the images and detection details will be dis-
played when the mouse cursor is held over a CAD object.

Figure 9-20 CAD Objects in a mammography image

True size
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The True Size selection displays the images in their true physical size and is toggled
on/off by pressing the icon again.

Pixel

The 1:1 Pixel feature displays the image in a state where one pixel on the screen con-
forms to one pixel in the image. When 1:1 Pixel is enabled, pixel interpolation is switched
off which allows viewing of the raw pixels. The tool is toggled on/off by pressing the
icon.

Link Mode

The Link tool links the images in the selected image panes together in scrolling,
zooming and panning. If possible, scrolling is linked spatially if not, it is frame-based.
The Link Mode is only available in overview mode.

Easy Mammo Survey

The Easy Mammo Survey is a tool which makes it possible to traverse the mammo
image at a 1:1 Pixel zoom level. When 1:1 Pixel mode is activated, the image is often
larger than the image pane which makes it difficult to view the whole image. An easy
way to assess the whole image and compare it with other images is to use the Easy
Mammo Survey tool.
When the Easy Mammo Survey tool is activated the 1:1 Pixel mode is activated along
with the Zoom/Pan Viewer, and the Text overlays, Zoom, Rotation, and Flip functions
are deactivated.

The view of the image automatically starts from the upper right corner of the image. To
go through the image systematically by viewing the large image tile by tile in 1:1 Pixel
mode, press Space on the keyboard.
Each tile overlaps the next both in horizontal and vertical direction to insure that border
regions can be viewed in context.

To go back to the previous tile use the shortcut, Shift+Space, and to deactivate the
Easy Mammo Survey tool press Escon the keyboard.

Toggle Zoom/Pan Viewer

When zooming an image it is easy to loose track of the precise zooming area in the large

image. The Zoom/Pan Viewer thus displays a thumbnail image of the large image
with a red frame in it to show which part of the image is displayed in the image pane.
To toggle the Zoom/Pan Viewer on/off, press the corresponding icon in the toolbar.

WARNING
The FDA recommends that only monitors and printers specifically
cleared for Digital Mammography use by FDA's Office of Device Eval-
uation (ODE) are used.
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9 Introduction to General 3D CAM
The General 3D Clinical Application Module (CAM) is one of the main tools for viewing
and processing patient image data in three dimensions. The 3D CAM is designed to vis-
ualize volume datasets such as CT or MRI series. In contrast to the 2D CAM the 3D
CAM makes it easy to obtain a spatial understanding of the contents of a dataset. This is
possible through various types of rendering methods:

DVR: (Direct Volume Rendering) which visualizes a solid volume of the 2D slices
MIP: (Maximum Intensity Projection) which is similar to DVR except that the data vol-
ume will display an image which represents the maximum value encountered.
MinIP (Minimum Intensity Projection) does the same as MIP, but it displays an image
which represents the minimum value encountered.
AvgIP (Average Intensity Projection) displays the average intensity projection.

9.11 Select Volume

The 3D CAM loads only a single volume at a time which must be a uniformly sampled
three-dimensional data set. The Volume Selection will open if more than one valid series
is available in the launched study. The Volume Selection dialog can be launched to select

another Volume via the Select volume from the File menu.

To select a volume, click it and use the two sliders at the bottom of the dialog to select a
slab of the volume for viewing. The sliders cannot be moved to specify a slab of fewer
than eight slices.

Figure 9-21 The Volume Selection Dialog

9.12 CAM overview

Only four window panes exist in the 3D CAM: the Volume rendering pane, placed in the
upper left corner, and three cross-sectional visualization panes called the Axial, Coronal
and Sagittal views.

Figure 9-22 Overview Mode
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To enlarge any of these four image panes to full-screen size, double-click in the pane, or
use the Enter key. To return to a previous CAM layout, press the Escape key or dou-
ble-click again.

9.13 The Volume Pane

Navigation in the volume pane is done through a number of functions:

Zoom: per default zoom is activated simply by scrolling. The zoom box can be activated

by the shortcut Shift+left mouse-click or from the toolbar .

Pan: Ctrl+left mouse-click or from the toolbar .

Rotation: per default rotation is activated via a left mouse-click or when other tools are

active Alt+left mouse-click, or from the toolbar .

Set Pivot: The Set Pivot function allows the user to change the center of the image
pane by moving the volume relatively to the center. Select the tool and left-click on the
position wished as the center.
As a shortcut the pivot point can be set by right-clicking in the volume pane.

NOTE
It is possible to toggle on and off the marker showing the center of the

image pane via the Toggle 3D Pivot in the View menu.

9.13.1 Clipping

Clip Planes are toggled on from the toolbar and will activate a clip box. The box con-
sists of 6 clip planes each of which can be individually controlled.
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To move a Clip Plane, click with the left mouse button on a Clip Plane and move it in the
direction suggested by the mouse cursor.

Figure 9-23 3D CAM - Clip Planes

Freehand Clipping allows the user to clip either inside or outside an area defined by the
user. The tools are available from the freehand clipping toolbar.
For both inside and outside freehand clipping the user inserts a number of points defining
the clipping shape.

1. Select the tool - clip inside or clip outside
2. Insert points on the volume pane to define the clipping shape
3. Double-click or right-click to finalize the shape and the clipping is performed either
inside (figure 1-4) or outside the clipping shape (figure 1-5).

Toggle clipping will toggle on/off the clipping shape, and Clear Clipping will
delete all freehand clipping from an image.

Figure 9-24 Freehand Clipping inside
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Figure 9-25 Freehand Clipping outside

9.13.2 Color Transfer Functions

The Color Transfer Functions Presets tab allows modification of Width/Level by the
use of color and is available next to the bookmarks tab.

• Select a color preset from the list and it will be applied to the volume.
• To deselect it press the same preset again or choose another one from the list.
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• To modify presets, right-click on the desired preset and select Edit.
• To create a new Color Transfer Functions Preset either right-click anywhere in the side-
bar and select Add new, or click on the More Options drop-down menu in the Sidebar
and then the Add new color preset. A preset editor dialog opens and the new preset set-
tings can be entered and saved.

Figure 9-26 A Color Transfer

9.14 MPR Panes

Navigation in the MPR panes is done through a number of functions:

Zoom: The Zoom function is activated from a menu or toolbar, or by using the
Shift+ LeftMouseButton.

• Click in the MPR panewith the left mouse button and drag the mouse to outline a rec-
tangular region which represents the area to be zoomed. It is also possible to zoom in 20
percent at a time by clicking with the left mouse button click in the image.

The Reset Pan/Zoom button cancels all zoom motions or operations that have been
performed for the selected image or series.

Pan: The Pan function is activated from a menu or a toolbar, or by using the
Ctrl+LeftMouseButton

• To pan an image, left-click in an MPR pane, hold down the left mouse button, and
move the mouse around to pan the image.

The Reset Pan/Zoom button cancels all pan motions or operations that have been per-
formed for the selected image or series.
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Rotation: Hold the cursor over the MPR lines of the MPR plane and rotate the plane via
Ctrl and a left mouse-click.

Scrolling: Scrolling is possible with the scroll wheel, left mouse-click+drag,
the arrows, or by selecting either one plane or the intersection of them.

Placing the mouse in an MPR-plane and pressing M on the keyboard is another way to set
MPR lines in an MPR plane.

It is possible to toggle MPR lines on and off via the icon in the toolbar .

9.14.1 Slab MPR/Thick MPR

Slab MPR is used to modify the slab by changing the thickness of the slab.

Slab MPR visualization is activated either from the toolbar or through the shortcut
Ctrl+Shift+left mouse-click. When activated a Slab 3D Mode icon is
shown in the right hand side of the image pane.
When Slab MPR is enabled for the first time, the slab thickness is set to default thickness.

Changing the thickness is done by dragging the stippled MPR lines or through the short
cut Ctrl+Shift+left mouse-click.
The slab thickness is displayed in the text overlay.

To disable the function either press the icon or the slab indicator icon displayed in
the right-hand side of the MPR image pane.

9.14.2 Synchronization

The pivot position and the MPR intersection is by default synchronized meaning that
manipulating one will affect the other. It is possible to disable the synchronization from
the Tool menu under Preferences so that either changes made to the volume will not affect
the MPR planes or vice versa. Likewise is it possible to toggle off both functions so that
neither the volume rendering nor the MPR planes are synchronized when the other is mod-
ified.

9.15 Annotation and Measurements

The Annotation toolbar contains a series of measurement tools for measuring distances,
angles and intensities of image data.

9.15.1 Measurement on MPR planes

Insert measurement:

1. Select a measurement tool
2. Left-click to insert control points for the measurement. Note that it is possible to use the
scroll wheel in between control points
3. Right-click to cancel or end the measurement.

Edit measurement:
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To edit a measurement drag the control points using the left mouse button. This will move
the control point in the current MPR plane. Right-clicking on a measurement will move
the current MRP plane to intersect with the control point.

Delete measurement:

To delete a measurement click on it in one of the image panes or in the sidebar and press
Delete on the keyboard.

9.15.2 Measurements on the Volume pane

Measurements can be inserted and manipulated in the volume view when MPR-mode is

enabled (but not in direct volume rendering mode). When the measurement is manip-
ulated in the volume view, the control points will always stick to the MPR planes.

Figure 9-27 3-Point Angle Measurement in the Volume view

9.15.3 Point of Interest

3D Point of Interest (POI) enables you to mark different MPR plane positions that
might be relevant to remember.

Select the POI tool from the toolbar to activate the cursor . When the tool is
selected insert one or more POIs by clicking on either the volume or one of the three
MPR panes. When a POI is inserted, it is marked by a POI graphic annotation which is
chosen as default or via the drop-down menu on the tool. Each POI is also displayed as a
bookmark on the sidebar which allows the user to easily switch between the POIs.
To activate or switch to a POI, simply click on the POI graphic annotation or the respec-
tive POI on the sidebar.

Figure 9-28 3D Point of Interest in 3D CAM
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To grab and move a POI place the cursor over the POI Left-click+drag.
To delete a POI, click on it and press Deleteon the keyboard. Alternatively, click on it
in the bookmark list in the sidebar and press Delete on the keyboard.

POIs are saved and loaded from compound presentations as described in chapter 7.

To deselect the tool Right-click or use the tool in the toolbar.

9.16 Vessel Tracking

Blood vessels in a MR Brain Angiography (MRA) series can be extracted and displayed

along with an MPR via the Vessel Tracking feature in the toolbar which activates the
function. To toggle it off press the small icon displayed in the image pane.

The dialog, Select New Threshold opens after activation and a threshold for the blood ves-
sel intensity can be set:
The threshold can be set on a calibrated scale from 0-100 and the threshold slider controls
the amount of voxels that can be included in vessel segments. If the slider is positioned at
100, it corresponds to 4.4 percent of the volume, and a slider position of 0 corresponds to
1.1 percent of the volume. The scale is logarithmic so that the middle position corresponds
to 2.2 percent of the volume.

When the threshold is set, click on OK to run the Vessel Tracking algorithm.

WARNING
The threshold slider must be used in order to obtain the best vis-
ualization of blood vessels.

Figure 9-29 Vessel Tracking
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10 Fusion 3D CAM
The Fusion 3D CAM allows viewing of dual modality studies. The CAM's primary func-
tion is to fuse two modalities to a single view, hereby combining anatomic information
with functional information.
The Fusion 3D CAM also allows the use of different color LUTs for visualizing the PET
series or the fused series, in order to emphasize and highlight concentrations of the radio-
nuclide (tracer material).

Modalities, for example CT and PET series, are fused into a 3D MPR series for easy loca-
tion of cancer tumors. Present example in Figure 10-1 shows three series: CT, PET, and
the fused images displayed in the Fusion CAM. All three series are displayed in Volume,
Axial, Coronal, and Sagittal views. The fused MPR view can be manipulated as any other
3D image which includes zoom, pan, rotation, moving the MPR plane location, and other
specific tools that relate to fused images.

Figure 10-1 Fusion 3D CAM. A PET series is fused with a CT series.

Fusion toolbar

The Fusion toolbar has been configured to include the most used tools when working
with fused images. The toolbar can be customized and set to fit any user needs.

Figure 10-2 The Fusion toolbar
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Color Look-Up Tables (LUTs)

The Fusion 3D CAM allows the use of different color LUTs for visualizing fused and
PET series in order to emphasize and highlight concentrations of radionuclide. It is pos-
sible to choose between several different color LUTs.

Automatic Volume Rotation

Images in the volume view can be automatically rotated:

• Click on Start Volume Auto Rotate to start rotation of the volume.
• Click on Stop Volume Auto Rotate to stop the rotation.

Rotation is then reset and the volume returns to its original position. Next to the Start and
Stop icons, the rotation speed can be adjusted in relation to degrees per second:

• Click on the up and down arrows or type a number in the box to set the speed.

Blending Value

The blending value of the fused series can be adjusted via the Blend feature on the Fusion
toolbar. Setting the blending value can also be done via the keyboard shortcut of
Ctrl+Alt, holding down the left mouse button and moving the cursor up or down. The

mouse cursor will change to . Values for the Lower and Upper Window respectively
are adjusted in the Fusion toolbar or in the LUT Viewer in the left-hand side of the dis-
play set window. The LUT Viewer is toggled on/off in the View menu.

Standardized Uptake Value Measurement (SUV)

SUV Measurements allow viewing of segmented measurements and is available in
both the Image Fusion 3D CAM and General 3D CAM. By inserting a measurement
based on specified thresholds, the SUV measurement area calculates minimum SUV, max-
imum SUV, average, and VOI volume in cm3.

Standardized Uptake Value (SUV) is a widely used, simple PET quantifier. It is cal-
culated as a ratio of tissue radioactivity concentration (for example in units kBq/ml) at
time T, C

PET
(T) and injected dose (for example in units MBq) at the time of injection

divided by body weight (for example in units kg).

SUV
bw
= C

PET
(T) / (Injected dose / Patient's weight)

It provides a quantification of size of the lesion and is an important tool when evaluating
the progress of a lesion.

The sidebar bookmarks make it easy to keep track of and switch between the various

measurements and results. The bookmark tab displays a list of existing SUV meas-
urements; allows the selection of an SUV measurement which makes it active and edi-
table; and allows changing of the min. / max. threshold for segmentation (g/ml).
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CAUTION
SUV Measurements require Attenuation Corrected PET series in
order to perform the measurements.

Figure 10-3 SUV measurement tool – 1) MPR planes, 2) SUV measurement box, 3) Book-
marks and measurement information, and 4) SUV threshold

Insert measurement

• Select the SUV Measurement tool from the toolbar or the Tools menu and the active
cursor changes to when it is possible to insert a SUV measurement. Click on one of
the three MPR views (not the volume view) to insert an SUV Measurement box which
has its center at the clicked point. This particular measurement is now in focus and is red.
In order to insert one or more measurements in the image, the tool has to be toggled again.
Once a measurement is inserted, the respective measurement results are displayed as a tool
tip when the mouse is positioned over the desired measurement. The results are also dis-
played in the bookmark.
Note that the SUV measurement has to be inserted in the fusion images or PET images.

Select a measurement

• To select a measurement, click on the SUV measurement box or click on the desired
measurement on the bookmark list. When the measurement has been selected, it becomes
red and is now in focus. Once a measurement is inserted or selected, the MPR planes
move and are positioned in the center of the measurement.
When a measurement is selected, it is automatically selected in the bookmark widget.
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Likewise, when a measurement is selected via the bookmark widget, the measurement
box in the MPR view is also automatically selected and in focus.

Edit the measurement

• To resize the measurement box, grab the edge of the box and drag to the desired size.
Resizing of the measurement is done in order to make sure that only the important part of
the volume is measured.
• To move the measurement box, place the cursor over the box, click and drag it to a new
position. The MPR planes move according to the new size.

Adjusting the measurement threshold

Each SUV measurement is based on a specific minimum and maximum threshold. In the
MPR views, the red areas display the pixel which are within the specified thresholds. The
thresholds are set to default parameters but are adjustable. In order to adjust the thresholds,
the measurement has to be selected. It is only possible to adjust one measurement at a
time.

Delete a measurement

• To delete a measurement, select it on either the bookmark list or click on it in one of the
MPR views, and press Delete on the keyboard.

NOTE
The SUV measurements are based on the following DICOM tags:

l (0018,1074) Radionuclide Total Dose
l (0010,1030) PatientWeight
l (0054,1102) Decay Correction
l (0018,1075) Radionuclide Half Life, and
l (0054,1001) Units.

If any of these tags are incorrectly entered in the dataset, the SUV
result cannot be trusted.
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11 Virtual X-Ray CAM
The Virtual X-Ray CAM is a 3D CAM that produces realistic and dynamic 2D x-ray
images from 3D CT volume data sets. The CAM allows the setting of Image Plate Posi-
tion in mm (how close the x-ray detector is behind the patient), the Source Position in mm
(how close the x-ray source is to the patient), the kVp setting in kV units (how much con-
trast the x-ray image contains), and the mAs Setting in mAs units (how bright the x-ray
image is).

Figure 11-1 Virtual X-Ray CAM - as the CT Volume is Rotated, a Realistic and Accurate
Virtual X-Ray is Produced.

The Virtual X-Ray CAM can produce accurate, virtual x-rays because CT data represents
actual physical density values. Thus, a CT volume can be used in a model that simulates
the passing of x-rays through the volume to produce a 2D x-ray view.

As the volume visualization is moved or rotated on the left side of the CAM, the cor-
responding 2D virtual x-ray on the right side of the CAM changes in response to the new
positioning. The image source is modeled as being in center and in front of the CT vol-
ume, while the image plate is modeled as being parallel to the display and behind the CT
volume. The manipulation of the Volume Visualization is done similarly manipulating
and controlling Volume Visualizations in the 3D CAM.
The volume visualization on the left of the CAM can be manipulated regarding window
width and window level or zooming, but these settings have no effect on the generated vir-
tual x-ray. Moving the cutting planes or (faces of the volume) will result in the excluded
volume data to not be used in generating the virtual x-ray.
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12 Document CAM
The Document CAM is used to display documents that are associated with a particular
patient or study. The primary purpose of the CAM is to display documents and to print
these documents. The Document CAM contains only basic CAM functions such as print-
ing, scrolling, and a few others.
The Document CAM is accessed in one of two ways: From the Workflow Manager, or
from the Taskbar once a CAM has been opened.
The dialog Choose Document is displayed for loading of chosen documents into the Doc-
ument CAM.

Figure 12-1 Document CAM
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13 Report CAM
The purpose of the Report CAM in EasyViz is to connect patient images and their cor-
responding reports. The result of a radiology study is the written report and the image,
therefore it is useful for clinicians and users if they have instant access to the written report
when viewing the images.
The Report CAM is a structured method of writing reports based on a predefined tem-
plate. EasyViz conforms to the DICOM Structured Report standard. A report consists of a
hierarchical collection of content items which together form the report. Describing images
using the SR format means that reports will have a uniform layout, which gives the author
an easy, fast, and similar way of creating reports, and which makes it easier to read reports
authored by someone else.
In EasyViz patient images are persisted into a PACS.

Navigation in the Report CAM

• To open the Report CAM from PACS, choose the required study in the WFM and click
on Report in the drop-down menu in the CAM selector column. When opening the
Report CAM from either the WFM or from one of the other CAMs a new report is auto-
matically created if the study does not already have an associated report: a new dialog
opens asking to choose which template to use.

EasyViz always has a default template installed. However, if this template does not fit the
user’s needs, a new template can be created from the WFM if the user has administrative
rights:

• To edit the default template, click on the Edit menu in the WFM and then on Edit SR
Templates.

By use of the Tab key on the keyboard, it is possible to tab through the various content
items of the report. The current item in focus will be denoted by a dashed line, and the
document item will have a yellow background.
When writing the report, text sections can be dragged and dropped inside the text item,
and between the various text items. It is also possible to drag and drop images from the
Patient Study Browser in the Sidebar into a thumbnail area of the report.

Delete and zoom

It is not possible for EasyViz users to delete a report. Only PACS administrators can do
this. However, it is possible to delete items in the report if the report is not in read-only
mode :

• Right-click on the item that is to be deleted and click on Remove.
• To zoom in the report, hold down the Ctrl key on the keyboard while either scrolling
up or down on the mouse wheel, or click either Ctrl++ or Ctrl +-.

Menubar

There are six default menus in the Menubar of the Report CAM:
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• File
• Edit
• View
• Document
• Tools
• Help

the functions below are described in detail as they contain functions not presented earlier.
The default menus File, Edit, and Help contain the same functions as in other CAMs. A
few tools from File, are, nevertheless, mentioned as they are named differently here.

New

To create a new report, click on New . Then choose a template from the list that
appears, and click OK. The new report will be created in a tab next to the report that was
already open.

NOTE
Creating a new report next to the original one can also be a way of
solving problems with reports containing errors, which cannot be cor-
rected due to for instance lack of free text sections in the template.
The error can then be amended in the new report.

Save

To save a report, click on Save in the File menu or on the tool button in the toolbar.
The Save DICOM Objects dialog appears asking for a PACS destination. A report can
also be saved by closing the CAM after changes have been made

Print

Click on the print tool button to print the report. A print dialog opens in which it is pos-
sible to select various print settings.

The View menu has three selections

Toolbars, Text Size, and Refresh Document.

The Document menu has six selections:

Complete, Verify, Clear Verification, Edit Report, Addendum to report, and History

The Tools menu has six selections:

Customize, Customize Keyboard Shortcuts, Activate Shortcut Mode, Preferences,
 Template Management, and DICOM Inspector

The Report CAM Toolbar

The default toolbar in the Report CAM consists of several tools, some of which are
known from the other CAMs, such as the Undo/Redo functions. The new functions
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which are presented in more detail in this chapter are the Complete , Verify , Clear
Verification , History , Edit Report , and Addendum to Report functions.
See 13 below for the default Report CAM Toolbar.

Refresh

To refresh the report when needed, click on the Refresh tool button in the toolbar. This
updates the report and shows changes.

Complete

This function should be used to show other readers that the report has been completed.
This is the case when all information has been entered into the report, and it is ready to be
verified by a radiologist:

• Click on the Complete tool button in the toolbar. This activates the Completion state
which is one of several states which serve to show where the report is in the process.

Verify

Once a report is completed, it has to be verified by a radiologist, and using this function
can be seen as a personal signature.

• To verify the report, simply click on the Verify tool button in the toolbar. The Verify
function can also used before the Complete option. In this case, the report will still have to
be completed afterwards.

Clear verification

Sometimes it can be necessary to change a report even though it has been verified. This

can be done by using the Clear Verification function and clicking on the tool button in
the toolbar.

Edit

An existing report can normally be edited, however, this depends on which type of doc-
ument template the report is based on. A report consists of content items which can be
filled out, and the number of these content items depend on the template.

• To edit each content item, click in the text field under the two headlines in each content
item. The Tab key on the keyboard can also be used to navigate between content items.
Remember to save the report after it has been edited.

Addendum to report

Even though a document template has been chosen before creating the report, certain con-
tent items in the report can still be added to fit the user’s needs, unless the report is read-
only.
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• Click on the arrow next to the Addendum to report and add any of the content items
to the report. The Addendum to report option can also be selected via the Document
menu.

History

It is possible to view previous versions of the opened report by clicking on the history but-

ton in the toolbar or on History in the Document menu. A History dialog opens listing
all previous versions of the report.

Read-only reports

Some reports may be in read-only mode which means that the current user cannot edit or
amend the report. A report may be read-only due to the user rights, the completion flag, or
one or more verification flags. Read-only mode will be denoted by a different background
color, either light pink or green.

Status of the report

In the bottom right of the screen, four boxes show the status of the report. The first box
describes the series which the report belongs to. The next two boxes show whether or not
the report has been verified or completed by the words Unverified/Verified and Not Com-
pleted/Completed respectively. The last box states whether the report has been modified
or if it is new.
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